
The PC Help Desk 1 of 14 4/25/2009 

 

Windows Vista Tips 
Learn quick ways to get the most out of Windows Vista. 

Get Started 

Get Back to the Desktop Quickly 

No matter how many windows you have open, you can always minimize all of them at 
once by clicking the Show Desktop button in the Quick Launch part of the taskbar in 
Windows Vista.  If you change your mind and don’t want to use the desktop, you can 
click the Show Desktop button again to restore all of your windows.  

Another way to accomplish the same thing is to hold down the < > key while pressing 
the <M> key.  This will minimize all open windows.  To restore them, hold down the 
<Shift> and < > keys while pressing the <M> key. 

Note:  If you don’t see the Show Desktop button, right–click an empty part of the 
taskbar, point to Toolbars, and make sure Quick Launch is checked.  If it’s not, then click 
it. 

Windows Vista has yet another way of getting to your Desktop quickly.  A lot of people 
are familiar with using the <Alt><Tab> key combination to switch from one window to 
another.  One of the items that will be on the list of open windows in Windows Vista will 
be Desktop.  Tabbing to this will minimize all windows and show the Desktop. 

Move or Copy Files to Subfolders 

You can use My Computer in Windows Vista to move or copy a file by dragging the file 
icon to a folder.  When you have Folders displayed on the left side of the window, it's 
easy to drag a file to a different folder. 

If the folder you want isn’t visible because the folder it’s in is not expanded, here’s a trick 
that will save you time and frustration.  Drag the file icon to the collapsed (unexpanded) 
folder, and hold it there for a few seconds.  The folder automatically expands and then 
you can drop the file into the folder you want. 

Ways to Delete a File or Folder 

When folders and files start to clutter up your hard disk, Windows Vista gives you 
several ways to get rid of the files and folders you don't want. 

Within My Computer, you can use any of these methods: 
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• Right–click the file or folder, and then click Delete.  
• Select the file or folder, and then press the <Delete> key.  
• Select the file or folder, click the File menu, and then click Delete.  
• Drag the file or folder to the Recycle Bin on the desktop.  

Note:  To access My computer, click on Start, and then click My Computer.  You can 
also use the hotkey, < >E. 

Move Backward and Forward Between Web Pages More Quickly  

In Internet Explorer 8 in Windows Vista, you can click the Back and Forward  buttons to 
move back and forth between pages you've recently viewed, one page at a time.  If you 
want to go back several pages and forward again more quickly, click the small black 
arrow next to the Back and Forward  buttons to see a list of pages you’ve recently 
viewed—and then just click the page you want. 

Find Your Way Back to a Web Page You Saw Some Time Ago 

To find a page that you visited days, weeks, or even months ago, but which you never 
added to your Favorites, you can use the History  list in Internet Explorer 8 in Windows 
Vista to help track it down.  Press <Ctrl ><Shift><H> or click on the View menu, pause 
your mouse on the Explorer Bars and then click on History .  The History  bar appears, 
containing shortcuts to every page you've been to today, yesterday, the day before, and so 
on for the previous three weeks.  The links are organized by week.  To find the link you 
want, click the week that you believe you saw it.  Links in each week’s groupings are 
listed alphabetically. 

Note:  You can change the number of days that pages are saved in the History  list (click 
Tools, then click Internet Option , and then look for the History  section of the General 
tab). The more days you specify, the more disk space is used on your computer to save 
that information. 

Rearrange and Resize Toolbars in Internet Explorer 

With Internet Explorer 8 in Windows Vista, you can move your menu bar, toolbar, Links 
bar, and Address bar to create more room to view Web pages or to customize your 
browser for efficiency's sake. 

Simply point to the vertical bar on the left side of the bar you want to move.  When the 
pointer changes to a double–headed arrow, drag the toolbar to where you want it.  You 
can move it left, right, up, or down. 

Are You Linked to a Workgroup? 

To determine whether your computer is linked to a workgroup. 
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1. Click Start.  
2. Right-click My Computer.  
3. Click Properties from the drop-down menu that appears.  
4. Scroll down to the Computer Name and Workgroup . 

Windows Easy Transfer Wizard 

Using the Windows Easy Transfer Wizard 

The Files and Settings Transfer Wizard helps you move your data files and personal 
settings from your old computer to your new one, without having to repeat much of the 
same configuration you did with your old computer.  For example, you can take your 
personal display properties, folder and taskbar options, and Internet browser and mail 
settings from your old computer and place them on the new one.  The wizard will also 
move specific files or entire folders, such as My Documents, My Pictures, and 
Favorites. 

To access the Windows Easy Transfer Wizard 

To open the Windows Easy Transfer Wizard, click Start, click on All Programs, click on 
Accessories, click on System Tools, and then click Windows Easy Transfer. 

Going Solo? 

If you're a party of one—sole owner and user of a computer—you might still want to set 
up your computer with user accounts, naming you as computer administrator and 
protecting the account with a password.  Doing so prevents casual access to the system by 
others if you leave your computer unattended while logged onto Windows Vista, 
provided you log off from your account. 

For added security, disable guest access. Here's how: 

1. Click Start, and then click Control Panel.  
2. Click User Accounts.  
3. Click Change an account, then click Guest.  
4. On the What do you want to change about the guest account page, click 

Turn off the guest account.  

Personalize Your Computer 

Add a Shortcut to Your Desktop 

A quick way to open files or folders or start your programs is to place a shortcut icon on 
the desktop.  Here’s how: 

To place a shortcut icon on the desktop 
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1. Right-click Start, and then click Explore.  
2. Locate the folder, file, or program, and then right-click and hold the item and 

drag it to your Desktop.  
3. Release the right mouse button to get a context sensitive menu.  
4. Click Create Shortcuts Here.  

Display the Quick Launch Bar 

If you have opened more than one program, you might like to display and use the Quick 
Launch bar.  The Quick Launch bar makes it easy to access frequently used programs like 
Windows Media Player and your E-Mail, and to open an Internet Explorer window.  
Windows Vista loads several programs in the Quick Launch, including Show Desktop 
and Switch between windows.  One click on Show Desktop minimizes all the programs 
on your desktop.  Another click restores them just as you'd left them.  

To display Quick Launch on the taskbar: 

1. If the Quick Launch bar is not displayed, right-click an empty area of the 
taskbar and point to Toolbars and then click on Quick Launch.  

After Quick Launch is displayed, click Show Desktop to minimize all open programs. 

Keyboard Shortcuts 

When speed counts, the keyboard is still king.  Almost all the actions and commands you 
can perform with a mouse you can perform faster using combinations of keys on your 
keyboard.  These simple keyboard shortcuts can get you where you want to go faster than 
several clicks of a mouse.  You’ll work faster on spreadsheets and similar documents, 
too, because you won’t lose your place switching back and forth between mouse and 
keys. 

Here are some of the most useful keyboard shortcuts: 

To Press 

Copy. <Ctrl>C 

Cut. <Ctrl>X 

Paste. <Ctrl>V 

Undo. <Ctrl>Z 

Delete. <Delete> 

Delete selected item permanently without 
placing the item in the Recycle Bin. 

<Shift><Delete> 
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Copy selected item. <Ctrl> while dragging an item 

Create shortcut to selected item. <Ctrl><Shift> while dragging an 
item 

Rename selected item. <F2> 

Move the insertion point to the beginning of 
the next word. 

<Ctrl><Right arrow> 

Move the insertion point to the beginning of 
the previous word. 

<Ctrl><Left arrow> 

Move the insertion point to the beginning of 
the next paragraph. 

<Ctrl><Down arrow> 

Move the insertion point to the beginning of 
the previous paragraph. 

<Ctrl><Up arrow> 

Highlight a block of text. <Ctrl><Shift> with any of the 
arrow keys 

Select more than one item in a window or on 
the desktop, or select text within a 
document. 

<Shift> with any of the arrow keys 

Select all. <Ctrl>A 

Search for a file or folder. <F3> 

View properties for the selected item. <Alt><Enter> 

Close the active item, or quit the active 
program. 

<Alt><F4> 

Close the active document in programs that 
allow you to have multiple documents open 
simultaneously. 

<Ctrl><F4> 

Switch between open windows. <Alt><Tab> 

Cycle through items in the order they were 
opened. 

<Alt><Esc> 

Cycle through screen elements in a window 
or on the desktop. 

<F6> 

Display the Address bar list in My 
Computer. 

<F4> 

Display the shortcut menu for the selected 
item. 

<Shift><F10> Equivalent to right-
clicking on the item. 
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Display the System menu for the active 
window. 

<Alt><Spacebar> 

Display the Start menu. <Ctrl><Esc> or press the 
<Windows> key 

Display the corresponding menu. <Alt> Underlined letter in a menu 
name 

Carry out the corresponding command. Underlined letter in a command name 
on an open menu 

Activate the menu bar in the active program. <F10> 

Open the next menu to the right, or open a 
submenu. 

<Right arrow> 

Open the next menu to the left, or close a 
submenu. 

<Left arrow> 

Refresh the active window. <F5> 

View the folder one level up in My 
Computer. 

<Backspace> 

Cancel the current task. <Esc> 

Prevent the CD from automatically playing. <Shift> when you insert a CD into the 
CD-ROM drive 

Use these keyboard shortcuts for dialog boxes: 

To Press 

Move forward through tabs. <Ctrl><Tab> 

Move backward through tabs. <Ctrl><Shift><Tab> 

Move forward through options. <Tab> 

Move backward through options. <Shift><Tab> 

Carry out the corresponding command or select the 
corresponding option. 

<Alt> Underlined letter 

Carry out the command for the active option or button. <Enter> 

Select or clear the check box if the active option is a check 
box. 

<Spacebar> 

Select a button if the active option is a group of option Arrow keys 
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buttons. 

Display Help. <F1> 

Display the items in the active list. <F4> 

Open a folder one level up if a folder is selected in the Save 
As or Open dialog box. 

<Backspace> 

If you have a Microsoft Natural Keyboard, or any other compatible keyboard that 
includes the Windows logo key  and the Application key , you can use these 
keyboard shortcuts: 

To Press 

Display or hide the Start menu.  

Display the System Properties dialog box.  <Break> 

Show the desktop.  D 

Minimize all windows.  M 

Restores minimized windows.  <Shift>M 

Open My Computer.  E 

Search for a file or folder.  F 

Search for computers. <Ctrl>  F 

Display Windows Help.  <F1> 

Lock your computer if you are connected to a network domain, or 
switch users if you are not connected to a network domain. 

 L 

Open the Run dialog box.  R 

Display the shortcut menu for the selected item.  

Open Utility Manager.  U 

Helpful accessibility keyboard shortcuts: 

To Press 

Switch FilterKeys on and off. Right <Shift> for eight seconds 

Switch High Contrast on and off. Left <Alt> left <Shift><Print screen> 
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Switch MouseKeys on and off. Left <Alt> left <Shift><Num lock> 

Switch StickyKeys on and off. <Shift> five times 

Switch ToggleKeys on and off. <Num lock> for five seconds 

Open Utility Manager.  U 

Keyboard shortcuts you can use with Windows Explorer: 

To Press 

Display the bottom of the active window. <End> 

Display the top of the active window. <Home> 

Display all subfolders under the selected 
folder. 

<Num lock><Asterisk> on numeric 
keypad (*) 

Display the contents of the selected folder. <Num lock><plus sign> on 
numeric keypad (+) 

Collapse the selected folder. <Num lock><Minus sign> on 
numeric keypad (-) 

Collapse current selection if it's expanded, 
or select parent folder. 

<Left arrow> 

Display current selection if it's collapsed, or 
select first subfolder. 

<Right arrow> 

Notes: 

• You must associate a password with your user account to secure it from 
unauthorized access.  If you do not have a password associated with your user 
account, pressing the +L will not prevent other users from accessing your account 
information.  

• Some keyboard shortcuts may not work if StickyKeys is turned on in Accessibility 
Options.  

• If you are connected to Windows through Microsoft Terminal Services Client, 
some shortcuts have changed.  For more information, see the online documentation 
for Terminal Services Client.  

Taskbar Taking Up Too Much Room? 

Is the Taskbar taking up too much room?  You can move it to any convenient location—
simply drag it to the sides, top or bottom of your screen!  You might need to unlock the 
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taskbar first.  To do this, right-click any open area on the Taskbar, then click Lock the 
Taskbar to clear the check mark. 

Add Favorites with One Keystroke 

You can quickly add a Web page to your Favorites folder with a single keystroke.  The 
page is automatically added to your Favorites list without any further input from you. 

Press <Ctrl>D. 

Set Your Browser to Open to a Page of Your Choice 

Is there a site you always visit first when you browse the Web?  Would you like it to be 
the first site you see when you start Internet Explorer?  Just follow the steps below to 
change your home or “start” page. 

1. Navigate to the Web page you want to see when you start Internet Explorer.  
2. Click Tools on the menu bar, and then click Internet Options.  
3. In the Home page area, click Use current . 

Make Sure Downloaded Files Are Easy to Find Later 

With Windows Vista, it's easier than ever to download software updates, games, sounds, 
pictures—just about anything.  But sometimes it's hard to find them again on your hard 
disk.  To make sure you can, specify where you want a downloaded file to go. 

1. After you’ve indicated you want to download an item, a dialog box asks “What 
do you want to do with this file?” Select Save this program to disk.  

2. A dialog box opens where you can specify a folder where you want the file to 
go. 

Use Single-Click Everywhere 

With single–click in Windows Vista, navigating the files and folders on your hard disk is 
as easy as navigating the Web. You single-click an icon to open a program or document. 

1. In the Control Panel, click Folder Options.  
2. In the Click items as follows section, click Single–click to open an item (point 

to select).  

Turning AutoComplete Addresses On or Off 

The AutoComplete feature in Windows Mail in Windows Vista saves you time by 
automatically completing addresses that you type when composing E–Mail messages.  
However, if you don't want to use this feature, you can easily turn it off. 



The PC Help Desk 10 of 14 4/25/2009 

 

1. On the Tools menu in Windows Mail, click Options.  
2. Click the Send tab, and then clear the Automatically complete E–Mail 

addresses when composing check box. 

Change Your Wallpaper 

The graphical background of your desktop, whether it’s a picture or just a pattern or 
color, is called wallpaper.  It’s easy to change your wallpaper 

1. Right–click the desktop, and then click Personalize.  
2. Click the Desktop Background, click an item in the Background list or browse 

to a different item if the one you want isn’t displayed.  

Use a Web Graphic for Your Wallpaper 

With Windows Vista, when you are on the Web and see a picture that you like for your 
wallpaper, you can easily save it and use it.  Simply right–click the picture or background 
you want to use, and then click Set as Background. 

Set Your Windows So They All Have the Same View 

If you like to see lists of your files in a certain way—as large icons, for example, or with 
detailed information—Windows Vista lets you set your view options for all your folders 
at once the way you want them. 

1. In the Control Panel, click Folder Options.  
2. Click the View tab.  
3. Set the view for this folder the way you want it to be for all folders.  
4. Click Apply to Folders, then click Yes to confirm, and click OK .  

Customize the Taskbar 

With Windows Vista, you can customize your taskbar so you can do everything from one 
place, including start programs, view documents, and surf the Web.  Simply right–click 
the background of the taskbar, point to Toolbars, and then click the toolbar you want to 
add: an Address bar, a Links bar, a toolbar containing all items on your desktop, or the 
Quick Launch bar. 

You can also create your own toolbar from any folder. 

1. Right–click the background of the taskbar, point to Toolbars, and then click 
New Toolbar.  Navigate to the folder you want.  A toolbar containing all items 
in that folder will be added to your taskbar.  

2. You can drag the new toolbar to any location on your desktop. You can also 
easily remove a toolbar from the taskbar by right–clicking the taskbar and then 
clicking the item again to remove the check mark. 
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Show Hidden Program or System Files 

Showing hidden files can come in handy—for example, say you've tried to delete 
everything from a floppy disk and the disk properties still indicate 100K of disk space is 
being used by hidden files. 

1. In the Control Panel, click Folder Options.  
2. Click the View tab.  
3. Under Hidden files and folders, click Show hidden files and folders.  

Enjoy Music 

Control Audio Quality  

Windows Media Player for Windows Vista lets you control the reproduction quality of 
CDs you record.  By reducing the quality, each track on your CD will take up less space.  
This allows you to accommodate more tracks up to the 650 MB capacity of the disk.  
Here's how: 

1. On the Tools menu, click Options.  
2. On the Burn  tab, move the sliding control to where you’d like it—to the left to 

create more space on each CD, to the right for the best stereo quality.  
3. Click Apply . 

Save Space on Your Hard Disk 

Concerned about your hard disk space?  Windows Vista is designed to minimize the 
space on your hard disk taken up by audio recordings, and you can reduce the amount 
even more by choosing to save music at a slightly lower reproduction standard.  It’ll still 
sound great but it won’t use up as much of your hard disk. 

1. On the Tools menu in Windows Media Player, click Options.  
2. On the Rip Music tab, move the sliding control to where you'd like it—to the left 

to use the least amount of your hard disk, to the right for best audio reproduction. 
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3. Click Apply .  

Work With Photos 

Rotate Pictures with a Click 

What if you take a picture with the camera turned sideways to get a tall image into the 
frame?  No problem.  Use the toolbar in Windows Picture and Fax Viewer to flip the 
image right-way up. 

1. Click Start, and the click Pictures.  
2. Double-click the picture you want to work with to launch Windows Photo 

Gallery.  
3. To rotate pictures, click the green rotation buttons on the toolbar under the 

picture. One button rotates pictures to the left, the other to the right.  
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With the toolbar you can also zoom in for a closer look at any area of a photo, and 
enlarge an image to its actual size.  Simply locate the picture you want to work with in 
Pictures, and then double-click it to start the Windows Photo Gallery. 

Do You Have an Older Digital Camera? 

If your camera does not have a USB connection, it’s easy for you to manually install the 
necessary software supplied by the manufacturer to enjoy the photo features of Windows 
Vista. Here’s how: 

1. Click Start, click Control Panel, and then click Scanners and Cameras.  
2. Click Add device….  
3. In the Scanner and Camera Installation Wizard, click Next.  
4. Click the manufacturer and model from the Manufacturer  and Models lists, and 

then click Have Disk.  
5. Insert the disk containing the camera software, and then follow the instructions on 

the screen.  

If your camera is not listed in the Scanner and Camera Installation Wizard, or if you 
don’t have a disk containing the software, connect the camera to the computer and try 
locating compatible software by clicking Add Hardware.  Then follow the instructions 
on the screen. 

You can also install the software controlling your camera or scanner, especially if it is not 
a USB (Universal Serial Bus) device, by using the Add Hardware Wizard in Control 
Panel.  Afterward, connect the camera to the computer. 

Communicate 

Search for Information From the Address Bar in Internet Explorer  

You can quickly search for information on the Web using the AutoSearch feature in 
Internet Explorer 8 in Windows Vista.  In the Address bar, simply type “go” or “find” or 
“?” followed by a keyword or phrase, and then press <Enter>. Your search results will 
soon appear. 

Note:  Internet Explorer searches for your word or topic using only one search service.  If 
you don’t find what you need, click the Search button on the toolbar and try using 
different search services. 

Save Time and Effort in Typing URL Addresses 

With Internet Explorer 8 in Windows Vista, typing Web addresses can be a breeze.  Here 
are some tips to make it even easier. 
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• Type something you remember about the address of website you want.  Internet 
Explorer will present a list of websites it feels you’re interested in.  If you see the 
website you want listed, simply click on it. 

• If you need to edit an address, you can use <Ctrl><Left arrow> and 
<Ctrl><Right arrow> to easily move between different parts of the address 
separated by periods.  

Opening a Web Page in a New Window 

When surfing the Web, sometimes you might want to check out a Web page and at the 
same time stay on the page that gave you the link in the first place.  With Internet 
Explorer 8 in Windows Vista, that’s exactly what you can do.  Simply press and hold 
down the <Shift> key while you click the link.  The page will open in a new Internet 
Explorer window. 

Need to look at two Web pages side by side?  That’s easy too.  To view any open 
windows side by side, right-click an empty part of the taskbar (the bar at the bottom of 
your screen), and click either Show Windows Stacked or Show Windows Side by Side. 

Maintain Your Computer 

Some Straightforward Talk on Virus Prevention 

Computer virus threats often sound alarming, but some common sense and a dose of 
protection will help you ward off even the most malicious Internet illnesses. 

Protect yourself now.  Here are some easy–to–follow rules to reduce your chances of 
suffering the consequences of a virus: 

• Always use up–to–date anti–virus software on your system.  
• Keep your anti–virus program updated to stay ahead of any new viruses.  
• E–Mail itself cannot infect your computer, but if you open an infected attachment 

in E–Mail, it can infect your computer.  Therefore, you should turn off any 
features that automatically open E–Mail attachments or launch programs you 
download.  


